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Initial set up

To begin, download the Exploren app and set it up using your
work credentials provided by your Fleet Manager.

Pairing the Charger with the app

Often the unit will be pre-commissioned to your account if not follow instructions below.
Locate the Station ID on the Exploren sticker (side of the IQ Portable unit).

Scan the QR code.

Enter the 4-digit PIN from the Quick Start Guide.

- Ifyou’ve misplaced the PIN, contact your Fleet Manager.
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Refer to Page 6 for setup instructions.

EVERYDAY USE

Starting a charge

Plug the unit into a powerpoint.

Wait 60 seconds for the unit to connect to the internet.
Open the app and confirm the unit is online.

Plug the charger into your EV.

Start charging:

a. Use the app to begin the session, or

b. Tap your Exploren RFID card.

oSO

Stopping a charge

To stop charging, choose one of the following:
* Press Stop in the app,

e Tapyour RFID card again, or

* Press and hold STOP button on the unit

¢ Unlock the charging cable from your EV.



TROUBLESHOOTING & QUICK FIXES

Issue Solution

Power off at the powerpoint > Wait 90 seconds >
Re-check app pairing

Not connecting to internet

Wait 90 seconds to sync or try to rest the app.

MU If offline, history will upload once back online

Ensure 2+ bars of signal. Move unit to an area

Poor reception ) )
P with stronger reception

FREQUENTLY ASKED QUESTIONS

What happens when my car is full or hits the set % limit?

The charger enters a paused state and checks every 30 minutes to offer power. To end the
session, simply unlock the cable from your EV.

Can | leave the portable charger turned on?

Yes. You can leave it on or mount it using the hanging bracket. It consumes minimal power
while idle and remains available for daily use.

How do | turn the unit off?

1. Disconnect the cable from your EV.
2. Wait 90 seconds for data to upload.
3. Turn off the unit at the powerpoint.

/\ Do not turn off the unit while charging at the powerpoint. Stop charging and then turn off.

How do | check if the unit is online?

e Checkthe IQ Portable screen: must show 2+ bars of signal.
¢ Inthe app Home screen, the unit will display as Online.
- Ifonly 1 bar or greyed out, the unit is Offline. Validate via the app.

How can | change the electricity rate?

Contact your Fleet Manager to update electricity rates in the system. You can view your
monthly usage and cost in the app’s home section.

My unit won’t connect to the app.

1. Turn the unit off and on at the powerpoint.
2. Wait 90 seconds.
3. Ensure the unitis paired to your account.



My charging history isn’t showing.

1. Wait up to 90 seconds for data sync.

2. If the charger was offline when charging ended, the history will upload once it’s back
online.

3. Ensure the unitis online regularly.

Will RFID work when the unit is offline?

Not by default. Units are programmed to work only online for accurate data transfer.
Speak to your Fleet Manager if offline RFID use is needed.

Can | remove authentication in the app?

Most fleets require app or RFID authentication to track energy use.
Please contact your Fleet Manager regarding this setting.

Can | set the portable unit on a schedule?

This feature is usually an advanced feature to keep usage simple due to the slow charge
rate. Speak to your Fleet Manager for options.

WHEN TO CALL FOR SUPPORT

Contact support only if:

* You've tried all troubleshooting steps and the charger still isn’t working
* The Station ID sticker or PIN is missing

CONTACT INFORMATION

Fleet Manager:
* (Contact for PINs, settings, electricity rates)

Exploren Support:
* help@exploren.com.au
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STATUS ICONS

There are four icons located on the bottom of the screen for 4G/ Wi-Fi, Bluetooth, OCPP

server connection, and RFID reader status. Depending on the colour, they represent different
meanings:

Colour Meaning

White The function is up and running
Green Connection is established

Red 4G/Wi-Fi has no signal when 1 bar or less
Grey The function is turned off

LED Status Meaning:

Colour

Meaning

Static Green Light Charger is Ready/ Preparing/ Suspended EVSE or Suspended by EV
Flashing Green Light Charger is charging
Flashing Red light Charger is faulty

AMPS BUTTON:

This button is DISABLED when the charger is setup on Exploren.

STOP BUTTON:

Long press the STOP button to stop charging.




HOW TO SET UP EXPLOREN APP

Download and set up Exploren app:

Exploren allows you to add a home charger to the app, giving you insight into your charger’s
status, your charging history, smart scheduling, and more! Follow the steps below to add a
home charger to the Exploren app.

1 Download the Exploren app
from the Apple Store or the
Google Play Store. Search
“Exploren” or scan one
of the QR codes. Sign up
using your company email
address.

Your charger may come
oogle Pla
linked to your app already. ' App Store ?’ Jd Yy

If paired, ignore this step.

2 Navigate to the Home tab on ) -
the Exploren app. Tap on the
far-left icon along the bottom Add Home Charger
of the app. Follow these easy steps to add your Exploren

compatible home charger to enjoy smart charging
capabilities, view charging statistics, and monitor
charging remotely in real time.

1 Scan QR Code

Scan the QR code located on the sticker attached to
your charger.

Enter PIN

The PIN for your charger will be provided to you by
Exploren or your Building Manager. If you are having
any issues finding your PIN, please reach out to us at
hello@exploren.com.au.

Enjoy SMART Charging!

Once you add your home charger you will be able to
view your charging data, and configure SMART
charging.

Scan QR Code 8

L & B

Home Charging | Find Charger Scan QR

»


https://play.google.com/store/apps/details?id=au.com.exploren.cp.app&hl=en_AU&pli=1
https://apps.apple.com/au/app/exploren/id1561000164

3 Enjoy SMART Charging!
Once you add your home charger you will be able to
view your charging data, and configure SMART
charging.

3 Tapthe Scan QR Code

button.
[T |
4 Scanthe QR code onyour EV charger, or e)z

enter the 4-digit station ID. Your charging
station will have an Exploren sticker on it;
it will look similar to the image.

—— Scantobind —

If your charging station is missing this
sticker, call us at 1300 755 087 or email
us at help@exploren.com.au.

CHARGERID

100001|

exploren.com.au
1300 755 087

5 Enter the 4-digit PIN for your charger.

You should have been provided a 4-digit pin by either your fleet manager
or from us at Exploren. If you’re having trouble identifying the pin, call us at
1300 755 087 or email us at help@exploren.com.au.

Your charger will how be connected to the Exploren app. You can now start and stop
charging sessions using the following instructions.

Pin Number
Station ID




HOW TO USE

SECTION 1: START AND STOP FROM EXPLOREN

1 To start charging through the Exploren app, first
plug the charger into the wall outlet, if it’s the
7kW or 22kW version, please tighten the screw
collar to secure the connection and then turn
on the isolator. Wait for the charger to connect
to internet and the server, the Exploren app will
show Ready once it’'s connected, this can take Tap to confirm charge
up to 2 minutes.

Test - 8A Portable -

Please allow the unit to come online before
plugging in. The unit will say Ready.

Preparing

(= Monthly Charging Stats View >
% Energy 259 kWh

& costs $117

2 Once the charger is online and ready, plug ‘ @
the charger into the car and the Exploren app = Test-8APortable &
ask you to confirm the charging, tap on the
charger image to start charging or via an RFID
linked to your account - see RFID section.

Vo Ready

= Monthly Charging Stats
% Energy
& costs




3 Once the charging started,
you will see the charging
speed, duration and total
energy. To stop charging,
press the Stop button
on the app, you can also
stop by long pressing the e
physical STOP button on
the charger or stop from
your car (check owner’s
manual for instructions).
A summary page will
show after the charging is
finished.

= Test - 8A Portable & Session Summary

Offline charging:

In OCPP mode, if the charger goes offline, you can still charge with the RFID card associated
with your account, and the offline charging records will be uploaded to the server once itis
back online. Up to 50 offline charging records can be stored in the charger.

It’s important to regularly check the Explore app Home section to ensure all electricity,
pricing and energy data is being transmitted. If the charger is offline. Please reboot and
ensure it comes back online. If unable to get the unit online. Please reach out to Exploren.

©



SECTION 2: HOW TO PAIR RFID WITH EXPLOREN ACCOUNT

Your Portable may come with RFID preconfigured. If so, skip this step.

aokrowbd

Ensure your charger is plugged in, powered on, and connected to the internet. Open the
Exploren app and click the menu button.

The menu will appear with a range of options available. Choose RFID cards.

Choose add RFID Tag.

Read the Instructions and choose Scan QR Code.

Scan the QR code on the Exploren sticker of the charger. You can also enter the charger
ID manually. The charger ID can be found on the sticker on the side of the charger.

The screen should appear. Scan your RFID tag on the RFID section within 30 seconds to
complete the process. If charger has an RFID card pre-commisioned it will show in the
RFID section.

@ Exploren Charging < RFID Cards
imGupiomncomen

© You dort have any RFID tags registered 10 your
= NA ‘account.
=

pay v

[= charging History

Q Favorites

Redeem Voucher

&8 settings >

Tarms of Sevics >

Buy an RFID cad from EVSE's Wobsite!

Find us on Facebook

Connect o us vi Linkedin

HomeClogng  FdCharger Sean b . - Enter RFID Tag Manually

& Register RFID Tag Scan Charge Point QR Read RFID Tag

To register an RFID tag to your account, you need to

process following these steps: Tap your RFID tag at the RFID reader of the charge.
point

1. SCAN QR CODE

Scan the QR code of the charging station,

2. TAP RFID TAG AT READER

Tap your RFID tag at the selected charge point's
RFID reader.

3.COMPLETE SETUP

Enter a name for your RFID tag and select which
payment method it should be finked with it

Time remaining... 28 sec




WAYS TO CHARGE WITH RFID

The two RFID cards included in the box should be pre-linked to your Exploren account, if they
are not linked, please refer to the adding RFID section

To start charging:

1.

w

Plug the charger into the wall outlet, if it’s the 7kW or 22kW version please tighten the
screw collar to secure the connection and then turn on the isolator.

Wait for the charger to connect to internet and the OCPP server, the top right corner
should show Ready if it’s connected, this can take up to 2 minutes.

Plug the charger into the vehicle, and tap the RFID card on the RFID reader.

The charger will make a beeping sound, and, on the screen, it will show Starting indicating
the charging has started.

To stop charging:

1.

2.

3.
4.

You can stop charging from:

a. thevehicle,

b. the RFID card or

c. the Stop button on the charger.

To stop with the vehicle, use the vehicle app or screen to unlock connector or stop
charging.

To stop with the RFID card, simply tap the same RFID used to start charging on the RFID
reader, the screen will show Stopping indicating the charging is stopping.

To stop with the Stop button, long press the STOP button and the screen will show
Stopping.

After the charging has stopped, unplug the charger from the vehicle and place the rubber
cap back onto the connector.

You can leave the unit on or remove from the wall if you wish.

If the charger doesn’t start charging after swapping the RFID card, it means the card is not
linked to your Exploren account.



3. PLUG AND CHARGE MODE

If you wish to get reimbursement for the charging, please contact your fleet manager if plug and

charge is acceptable.

If the charger is set to plug and charge, you can start a charging session by simply plugging
the charger into your car. To stop charging, push the STOP button on the front of the charger.
You can also stop charging from your car (check car owner’s manual for instructions).

To set the charger to plug and charge on the Exploren platform, first go to the Exploren app
and select the Home tab, then select the setting button on the top right corner of the screen
and press “Configuration”.

Then go to “Authentication”, select “Not Required” from the drop-down menu and click “Save
Changes”

Test - 8A Pc X < Configuration < Authentication

& Configuration

 Raboot @ Name

Change the name of your home charger.

® Firmware Update
(%3] Photo

L] your home charger.

Authentication
@ tratlrdati utentaton o start
B

Connector Lock
& w o

Yo Ready Yo Ready

£ Monthly Charging stats e £ Monthly Charging Stats View >
Do Do e
& costs & costs s

DCUL,_/.\R @) ocularcharging.com.au

sales@ocularcharging.com.au
|Q PORTABLE R, 1300912650



